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Introduction Objectives

This manual is written to give you a step-by-step guide for your classroom training and a handy
reference for your daily work. In this Introduction, you will learn how to use this training guide
effectively. This section covers the following topics:

< An introduction to the Crystal Reports application
< Class objectives

< Help with using this training guide

< Information on how to start the program

About Crystal Reports

In today’s information intensive environment, every business has a database of some sort. After all,
business today is all about information and databases give you a handle on the

massive amounts of information you must deal with. Therefore, your business has a database and
from that database, you need reports. The problem is, most reporting capabilities that come with
database programs are limited. They only report on data from that program. Many users need to
report on data from multiple sources, even SQL (Structured Query Language) databases such as
Oracle, Microsoft SQL Server, Informix or Sybase.

Crystal Reports is one of the most powerful reporting programs available with the ability to pull
data from all types of data sources. You can use Crystal Reports to generate reports from any of the
standard PC database programs, Access, Paradox, or FoxPro, as well as from a mainframe or server
database. Crystal also has a powerful web-reporting server that allows you to distribute your re-
ports over the web.

Crystal Reports is bundled with more than 160 other programs including Visual Basic, some medi-
cal applications, many accounting packages and several ERP solutions. It makes report generation
easy without requiring you to be a programmer or a database expert. If you know how to work in
a Windows environment and are familiar with the data you want to use, you can create a Crystal
Report that looks professional and makes sense.

Training Philosophy

Studies show that people retain 10% of information they see, 20% of information they hear, 50% of
what they see and hear, and 80% of what they see, hear and do. In line with this concept, the class
utilizes a hands-on method of training. You will see the effects of new procedures on the screen,
hear the instructor explain how and why to use features, and perform the actions yourself as you
learn.

In addition, this class focuses on your ability to perform tasks using the most productive tech-
niques. The manual may contain several methods of accomplishing a certain task. However, class
time does not allow for practice of all methods for each task. Your instructor will guide you in the
most effective method of performing a task, but inform you of other methods that are available.

Questions are encouraged. While we give our best effort to explain new concepts in understand-

able terms, you may need to hear the concept again or have it explained more thoroughly. Please
let the instructor know when you need more information!
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Class Objectives

This class is a performance based instructional system. It is geared to provide you with the tools
you need to build and distribute reports the quickest, most efficient way. After completing this
course, you will be able to perform the following tasks:
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Plan and organize a report

Create a new report

Save and preview a report

Navigate through the report

Format and edit report objects

Use a report style for formatting

Add text objects to reports

Add lines, boxes, and graphics images to reports

Select specific data from a database

Group, sort and summarize reports

Create reports that pull data from multiple tables

Use the Formula Editor to perform number calculations
Create formulas that manipulate dates

Modify string fields using powerful text functions.
Conditionally format numbers with the Highlighting Expert
Format sections on the report

Use formulas to conditionally format any type of field
Create summary reports for efficient analysis of data
Add charts and customize how they look

Distribute reports throughout your organization with Crystal’s export feature
Create geographical maps for charting

Set up an ODBC connection to your database
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About This Manual

Each section of this manual contains objectives to provide you with the overall goals for the les-
son. Lessons have descriptions of features and concepts followed by systematic directions for
completing a specific task. Each section ends with a challenge exercise to help you practice the
skills you learned in the lesson. Challenge exercises provide you with tasks to accomplish. Try to
complete these exercises on your own.

As you work in this Training Guide, certain conventions are used to identify specific procedures.
Use the following table as a guide:

Training Guide Conventions

Item

Illustrated As

Menu Commands

Underlined letters for accessing menu commands are shown:

Example: File/Open

Command Buttons

Command Buttons in dialog boxes are shown as buttons:

Example:

Categories, Radio Buttons,
Text Boxes, Check Boxes

All options within dialog boxes are listed in italicized text:

Example: the Keep Group Together check box
the Other radio button

Keystrokes

Keyboard keys are indicated by uppercase text:
Example: press ENTER

Keyboard combinations are shown in uppercase text with a plus sign (+) between the
keys that need to be pressed simultaneously.

Example: press CTRL + S to save

Toolbar Buttons

Toolbar buttons are indicated by the button name and a graphic image of the button:

Example: click the Print Preview [& button

Typing or File Selections

Text to be typed or file names to be selected are printed in bold letters:

Example: type Henry
select grouping.rpt

Exercises

Step-by-Step exercises in the text are indicated by bold text and the %+ symbol.

For example:
*» Exercise - Format Objects
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Tips, Notes, and Warnings

Tips, notes and warnings display with the following icons. Text for these additional comments
display in bold and italics as shown below:

This icon indicates a tip or shortcut.

hi 1 This icon points out a note of additional information.

This icon calls attention to a warning or very important note
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Lesson Objectives

After completing this lesson, you will be able to:

< Use the Design and Preview windows to build reports
The Design window is the main window for building a report. Become productive in
putting together the basic items on the report, and then use the Preview window to
see the results of your work

R/

<> Place data fields on your report
Learn how to insert fields on the report

< Size and move objects
Learning how to manipulate the objects on the report gives you control over the look
and feel of the report

< Use guidelines to align objects

Guidelines provide an easy method for moving and aligning objects. Become
proficient at manipulating the guides and snapping objects to them

R/

< Create text objects
Add titles and other text to reports by creating a text object

R/

< Save and Preview the report

Learn about the Preview view and how to navigate through the report. Set up the
report to save automatically. Understand what happens when you refresh the data in
the report
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Starting the Crystal Reports Program

You can start Crystal Reports in one of three ways:

X Click the Start button | All Programs | Crystal Reports 2008 menu. Click on Crystal
Reports 2008
X If you prefer to use the My Computer icon or Windows Explorer, open either one of

these windows. Expand or open the C:\Program Files\BusinessObjects\
BusinessObjects Enterprise 12.0\win32_x86 folder, then double click crw32.exe

X If you have a desktop icon for Crystal Reports 2008, you can double click the desktop
icon to open the Crystal Reports program

Starting a New Report

When you first open Crystal Reports, the program helps you to begin creating a report by present-
ing the Start Page.

On this page you have two groups of options — START A NEW REPORT and MY RECENT REPORTS.

:
File View Help

[

Start Page *

CRYSTAL

REPORTS .

Business Objects

START A NEW REPORT MY RECENT REPORTS

* HIGHLIGHTS | v ] v E I : mPRof HA | =

FREE PRODUCT ADD-ONS
5 CHANGE THE FUTURE
»

2o OF THE DIAMOND TECHNICAL
Cry.stal Reports 2098 Service Pack 0 (SP0) is ) . \ COM_H__UN]‘B’! ,.-".
¥ available now and includes support for enterprise b, y o2 &
» workflows available with BusinessObjects Enterprise [#i8 ‘ N
» XI 3.0 N 4

Take the 10n|ii|-User Survey

Today!
(available for a limited time) ¥
Field Explorer | B2
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START A NEW REPORT

Under START A NEW REPORT you can use the Wizards to create a standard report; cross tab report;
mailing label report or a report against an OLAP cube. The Report Wizards are a series of dialog
boxes that assist you in creating a specific type of report by doing some of the work for you. You
will learn how to use a Report Expert later in this class.

You can also choose a Blank Report which is what you will do in this lesson.

My Recent Reports

If you have been working with reports you will see them listed here or you can choose to open
a report that you have stored on your system. Choosing open report will take you to windows

explorer where you can navigate through your folders to find the report.

If you click the * =lan« r=0ort option, Crystal takes you to the Database Expert screen in order to
select the report’s data source.

Choosing a Data Source
Whenever you create a report, the first thing you have to do is select a data source. Crystal uses a

dialog box called the Database Expert to present all possible data sources and allow you to choose
one or more for a report.

o ™

‘¢! Database Expert 3

Data

Browse the data source for the tables you want to add.

(Maote: to edit the alias for a table, select the table in the "Selected Tables"tree and click on it ar
press the F2 key)

Available Data Sources: Selected Tables:

[ My Connections
[ Create New Connection

OK || Cancel || Hebp

———————————eeeeeeee 10 ———————————eeeeeeee
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< The My Connections option displays the server or data file to
which you are currently connected or have connected to
previously. If you just opened Crystal Reports for the first time, this
option indicates no items found

< Create New Connection is the folder that contains all possible
data connections available for nearly any kind of database
including Oracle, SQL Server and Access

~¢ Database Expert

Data

Browse the data source for the tables you want to add.
{Mote: to edit the alias for a table, select the table in the "Selected Tables"tree and click on it ar
press the F2 key)

Available Data Sources: Selected Tables:
= 2 My Connections -

£ o items found. ..

= [ Create New Connection
[CIADO.NET ML)
[C1 Database Files
[Z3Java Beans Connectivi
[C3JDBC (JNDIy
[CI0DEC (RDOY)
EgoLapP
[CI0OLE DB (ADO)
[Z0 5alesforce com
[C3 Universes -

W
W

m

' m 3

[ ok || canced || Heb

———————————————————————————— " ————————————————————————————



Crystal Reports 2008 Designer 1 Workshop ©2008 Vision Harvest, Inc.
Lesson 1: Creating a Simple Report

Access/Excel (DAO) - Allows a direct connection to MS Access and other files using
Microsoft’s Data Access Objects and not ODBC

ADO.NET (XML) - Connects to ADO.NET datasets and also support connecting to DLLs
that return datasets

Database Files - Use this option to connect directly to PC data files that can be
accessed through a physical file location from the C: drive or other mapped network
drive. This option connects to Access, Paradox, Btrieve, DBase and Foxpro

JDBC (JNDI) - Java Database Connectivity (JDBC) enables a connection to databases
that require Java only connections. In most cases this connection is usefull when
Crystal Reports is embedded in a Java application.

ODBC (RDO) - The ODBC/RDO (Open Database Connectivity/Remote Data Objects)
folder is typically used for server-based databases like Oracle, Sybase, Informix, and
MS-SQL Server

OLAP - Use this option when creating reports using On-Line Analytical Processing
data sources

OLE DB (ADO) - This is a Microsoft data connection similar to ODBC in its concept and
requires the use of an OLE DB provider, which is similar to an ODBC driver

Salesforce.com - Use this connection to create reports for data stored in
Salesforce.com accounts. This connection requires an internet connection and proper
user credentials for the Salesforce.com account.

Universes - You can create a report from a Business Objects universe. Crystal Reports
lets you select a universe and design a query from it using a tool called the Business
Objects Query Panel

XML and Web Services - Allows reports to be created from an XML data source file or
from an XML Web Service

More Data Sources - This option allows access to other data sources using native
drivers and is dependant on the options selected as part of the installation process

= NOTE: You may be asked for the Install CD if the driver was not installed for the database you
[ have selected. In Crystal Reports 2008, not all drivers are installed by default. If you see this
message and do not have the CD, contact your system administrator.

12
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<> Repository shows a list of data source connections that have been stored in the
repository, usually stored SQL queries. Opening the repository folder will first ask you
to connect to Business Objects Enterprise. If you have the rights to do this then you
will see the repository. You can then select a SQL command or Business View if there
are any in the repository

o a1

@ Log On to BusinessObjects Enterprise (23]

Enter the name of your system (Central Management Server).
You also need to spedfy your user name and password.

System: ARKAMNTOS -

IUser name: Administrator

Password:

Authentication: [Er'lterprise - ]
[ OK ] [ Cancel ]

Choosing a Data Source

To choose a data source, click the Create a New Connection folder and select the data source you
want, for this class select Access/Excel (DAQO) and provide all required information the pop-up
dialog window requires.

Choosing the Access/Excel (DAO) data connection will activate the Access/Excel (DAO) dialog
window which provides the ability to select important database information such as the file name
and location, type and login credentials. For this class set the Database Type to Access and the
Database Name to point to the Northwind 2008.mdb file provided with the course class files. No
login information is required.
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Access/Excel (DAD)

Connection

Pleasge enter connection information...

Database Name:

Database Type:

Secure Logon:

[ratabaze Pazzword:

Sezgion UserlD:

Sezzion Pazaword:

System D atabaze Path:

CACR2008 Class Resources'Databases\MNothw

[Aecess )

(]

< Back MNext =

| Fnsh || Cancel | | Hep |

After finding the Northwind 2008.mdb file and selecting it, click the Finish button. The next screen
will prompt for a username/password if applicable. Respond to this screen and click Finish. Now
the database connection is established and the Database Expert reappears.

The Database Expert now shows the new connection along with available items that can be se-
lected for inclusion into the report. Some databases are able to determine which tables are avail-
able based on user login ID and therefore not all data tables may be shown.

14
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-y Database Expert (3]

Data

Browse the data source for the tables you want to add.
(Maote: to edit the alias for a table, select the table in the "Selected Tables tree and click on it ar
press the F2 key)

Available Data Sources: Selected Tables:

Views -
Stored Procedures
Create New Connection N
= [[DAccess/Excel (DAD)
45 Make New Connection
=R 7 C\CR2008 Class Resouls

1] Add Command
Tables
Views B
[E] Stored Procedures
[CJADO NET (¥ML)
(7] Database Files
[[1Java Beans Connectivity -

e,

4 | 1 | 3

[ ok || canced || Hep |

Depending on the database being accessed Commands, Tables, Views and Stored Procedures will
be shown and available for use in the report. It is important to understand the differences be-
tween each of these items.

<> Commands allow for custom Structured Query Language (SQL) to be used as a data
source. This means developers can now build complex queries using an advanced SQL
building tool like Toad or SQL Navigator and port the completed code into Crystal
Reports for use in the report

<> Tables are physical containers of data and are the only items that contain data and are
sometimes referred to as “physical tables”

<> Views do not contain data and are sometimes referred to as “logical tables”. These
tables are just queries which pull data from the physical tables. Views are usually
created by the Database Administrator to make database reporting easier for the end-
user to write reports

<> Stored Procedures are very similar to views in that they do not contain data. They are
sometimes referred to as “procs”. The differences between Views and Procs are in the
complexity of the query code used and the programming language used

To add a table to the report, expand the Tables folder and then click the move right button to add
the table into the right column labeled Selected Tables. Once all the tables are selected click the
OK button.

For this class, we are going to use an Microsoft Access database file named Northwind 2008 . This
sample database is included with the course class files.

e — 15 e —
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o,

+» Exercise 1.0 - Start a New Report

1. Click the e button, choose All Programs | Crystal Reports 2008 | Crystal
Reports 2008
The application opens and displays the start page.

2. Click the * =/ank r=port option from the START A NEW REPORT column
The Database Expert dialog box appears

3. Click the ® to the left of LI Create New Connection
The list of available data sources displays.

4, Find the Access/Excel (DAO) folder and double-click it
This activates the Access/Excel (DAO) dialog window. Please note double-clicking only
works on the first database connection created. Afterwards you must double-click the
Make New Connection item.

5. With the Access/Excel (DAO) dialog window open, make sure the Database Type: is set
to Access and the Database Name: is pointed the Northwind 2008.mdb data file

included with the course class files. Click

6. Now that the connection is established, verify the connection is now listed in the My
Connections folder. Do this by collapsing and expanding the folder or RIGHT click the
folder and choose Refresh
From the My Connections folder you will now see the new connection just created.

7. Expand the Tables folder and select the Customers table. Click on

8. The Customers table will now appear on the right list labeled Selected Tables:.

Click

The Crystal Reports Design window displays on the screen.

16
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The Design view in Crystal Reports contains all the report creation features needed to build a re-
port. Take a moment to look at the screen and identify the features of the Design window.

- Crystal Reports - [Reportl] - = X%
File Edit View Insert Format Database PReport Window Help

INE-HISpEL | & BB - |FEFE%Y R H

i | -|| A A B L a

RMEZIOLONCOBLGE0S

Start Page : Reportl =

Design |

Report Header

3

m

L

For Help, press F1

The window has the standard features of a typical Windows-based program. The following allow
you to execute commands and perform tasks in Crystal Reports:

The Menu Bar contains all the commands available in Crystal Reports. As with all
Windows programs you can open the menus by clicking with the mouse or by
pressing ALT + the underlined letter for the menu you want

The Toolbars contain buttons that are shortcuts to menu commands. You can view the
function of a button by moving the mouse pointer over the button. When you do this,
a Tool Tip displays the button name and the Status Bar at the bottom of the screen
displays the function of the button

TIP: You can open and close the toolbars by RIGHT clicking in the toolbar area. To hide a toolbar,
click the check mark to the left of the toolbar name. To show a toolbar, click the toolbar name.

K/
0’0

= 7

Below the tool bars are Report tabs for each report you have open plus the Start
Page tab. Clicking on the start page tab will take you to the following dialog:
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Start Page % | Reportl

START A NEW REPORT MY RECENT REPORTS

st Quarter 2004 Summarized.rpt

* HIGHLIGHTS I ¥ DOWNLOAD l * DEVELOPER ' * IT PROFESSIONAL '
FREE PRODUCT ADD-ONS CRYSTAL REPORTS 2008
» Sample R = + Databases PRODUCT UPDATE CHANGE THE FUTURE
> Crystal Reports 2008 Service Pack 0 (SP0) is s %g:ﬁ::lﬁtc"ﬂlcﬁl
H available now and includes support for enterprise B \ ° ®
E warkflows available with BusinessObjects Enterprise RS \ Y )
H XI 3.0

Take the 10min User Survey
CRYSTAL REPORTS TEAM

BLOG ON DIAMOND

Learn a few new tricks and share your opinions with
L "@*‘1’\ - < ; el s ey

Today!
(available for a limited time)

<> In addition to the START A NEW REPORT and MY RECENT REPORTS resources the
Start Page includes a live web page including numerous links to information, news
and resources available on the Business Objects web site.

< There is a Design tab for each report you have open. The Design tab indicates you are
in Design view. Once you have previewed the report, there is a Preview tab as well.
You can easily switch between Design view and Preview view by clicking the
appropriate tab

< The Status Bar displays at the bottom of the Design and Preview screens and
shows information about selected objects. If no object is selected, the Status Bar
shows information about the toolbar button to which the mouse is pointing,
information about the report itself, or help information

The default Design window is divided into five sections. Each section corresponds to a specific
part of the final, printed report. Section names display at the left of the Design window.

Report Header | ———

Page Header

— Sections

Each section has a bar at the bottom of the section that defines the height of the section. When
you place the mouse pointer over a section bar, the pointer changes to this image. Using this
pointer, you can drag the bar to make the section taller or shorter.
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Exploring the Toolbars

Crystal Reports has six toolbars.

R/
0'0

R/
0'0

0
0'0

R/
0'0

7
0'0

R/
°

1.

2.

Standard - Contains buttons for basic editing commands such as Save, Open, Preview,
Cut, Copy, Paste, Undo, and Help

Formatting - Has buttons for formatting commands such as Bold, Italic, Underline,
Alignment, and Number formats. Most of these buttons are not active unless you have
an object selected

Insert Tools - Includes buttons for adding various report objects into the report, such
as Text Objects, Grouping, Summaries, Cross-Tabs Lines and Boxes. These buttons are
generally active and available for all reports

Expert Tools - Provides buttons for modifying and formatting such items as Charts
and Maps using an Expert wizard. These buttons may or may not be active depending
on the button and the object it represents

Navigation Controls - Offers buttons for refreshing the report data and for moving
around your report. These buttons will not be active unless in Preview mode

External Command - Displays icons to access available, registered third-party
applications designed to work within Crystal Reports. Add-in applications are
registered within Crystal Reports simply by adding the application’s DLLs in the Addins
directory of the Business Objects install folder. Additional information can be found in
the Crystal Reports .Net Developers Guide

++ Exercise 1.1 - Explore the Design Window

To begin, open the Field Explorer by clicking the [=licon

When you have the Design window in front of you, take a few moments and practice
these steps before adding data fields:

a) Move the mouse pointer across the Toolbars, reading the tool tips that appear
when you touch the pointer on the buttons

b) Run your mouse across the options on the Menu Bar, just above the Toolbar, click
once to read the menu choices to familiarize yourself with the terms used by
Crystal Reports

¢) Place the mouse pointer over the Section boundaries and stretch them up and
down

I —— 19 I ——



Crystal Reports 2008 Designer 1 Workshop ©2008 Vision Harvest, Inc.
Lesson 1: Creating a Simple Report

Managing Resources with Explorers

Managing resources are done through three Explorer components.

R/
°

R/
0.0

play.

Field Explorer - Use the Field Explorer to insert all types of fields into the report. The
Field Explorer lists the seven types of fields you can insert into a report: Database,
Formula, SQL Expression, Parameter, Running Total, Group Name, and Special fields.
With the icons at the top of the Field Explorer, you can manipulate the fields in the list

Field Explorer a =

£ | = 2B EY
= [ Database Fields

B Customers

i Formula Fields

EM SQL Expression Fields

Parameter Fields

#* Running Total Fields

{= Group Mame Fields
¥ special Fields

Repository Explorer - This powerful feature offers the report developer the chance to
save several kinds of objects for re-use in subsequent reports. Although formulas may
not be stored in the repository, many other useful items can be. Items which can be
saved are:

) Formatted Text Objects
O Graphic Images

0] Custom Functions

0] Commands (Queries)

NOTE: The Repository Explorer can only be accessed via the Repository, which is now incorpo-
rated into Enterprise. If a user tries to access this feature, a login prompting window will dis-
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< Report Explorer - Another very useful feature is the Report Explorer. This tool
represents all the sections and objects in the report in a tree-node fashion. In
addition to making it easier to find a particular object or section, this explorer allows
a user to select an item or items within the group tree for editing purposes. Simply
right click on the item to view the editing options available

Report Explorer o =

% ||= |}
= 4 Reportl
= Report Header
= &= Page Header
~{#a] Textl: CompanyMame
= =] Details
22 CompanyMame 1: Customers.CompanyMame
l.'.—_..j Report Footer
l.'.—_..j Page Footer

Field Explorer s Report Explorer |

The explorers can easily be turned on or off for viewing, but are normally docked to the right of the
report design area. To “un-dock” an explorer, simply drag it by the title bar to the left of the report
or RIGHT click and choose “Undock”. To view an explorer, pull down the View menu to see a list of
the three available explorers.
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Placing Fields on the Report

As you look at the Field Explorer, you will notice there are several categories of object types with
each category being represented by an icon to the left of the name. Expand the Database Fields
folder to see available tables and fields. Expand a table to see available fields contained in that
table.

The Field Explorer is automatically docked to the right of the design area. If you prefer to have it
floating (un-docked) or in another location, just drag it by its title bar. If you change your mind,
just reposition it back to the docking area. The Field Explorer can also be docked to the left of the
design area. And finally, the Field Explorer can also be closed any time and re-opened by clicking
the [=licon.

There are several ways to place fields onto the report. The Field Explorer dialog box provides ac-
cess to all the fields in the table(s) you selected when beginning the report. Using the Field Explor-
er dialog box, you can place a field in the report in one of three ways:

& Select the field in the list, then click the Insert Fields = button, and then click in the
report where you want the field to appear

X Drag the field to the report. Release the mouse button when the pointer is pointing
where you want the field to appear

X Right Click on the field and chose Insert to Report from the Short Cut Menu, then click
in the report where you want the field to appear

Typically, you would place fields in the Detail section of a report. When you place a field in the
Detail section, Crystal Reports adds a Field Header directly above the data field in the Page Header
section. The field defaults to the actual size of the field in the database or to the size of the field
name, whichever is longer. This is very helpful for identifying the field at a glance.

WARNING: If you place a field in any section other than the Detail section, Crystal Reports does

NOT create a Field Header in the page header section of the report. Even if you later move the
field to the Detail section, the Field Header is not created automatically.

NOTE: If you delete the field object from the report, Crystal Reports will normally remove the
Field Header from the report as well.
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+ Exercise 1.1 - Place Fields in the Detail Section of the Report

Make sure the Field Explorer is open. If it is not click the [=licon in the
Standard Toolbar

Expand the Database Fields node, find the Customers table and expand it to see a list
of available fields

Select the CustomerlD field in the list of fields

Click the = button on the Field Explorer toolbar
The mouse pointer appears as a © symbol when it is pointing to a location where you
cannot place a field.

Move your mouse into the Details section at the left side of the report and LEFT click
aC?)?slpal Reports places the field in the details section and the field name in the Page
Header section.

Using the same method, add the CompanyName field to the right of CustomerID
Use the Drag and Drop method to add the City field

LEFT-mouse drag the Region field to the Details section after the City field

Your design area should look similar to the example below:

Design '-':-,
W
R R R R - KA U ISR R > A IR AR R -
Report Header . ' ! -
Fege Hedr N i |
Customerld E;omgangName City Reagion
Details | CustomerlD, CompanyName City ‘Region 1]

& NOTE: In the Field Explorer, you should see a green check mark on the icon to the left of each
field you add to the report.
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Selecting and Sizing Objects

Once a field is placed on a report, it is good practice to resize it to a proper character length. When
Crystal inserts the field, it is the same size as the data field in the database, or the size of the field
name, whichever is larger. To resize the field to a size you want, you must select it first. When a

field is selected, a blue dot appears at the center of each of the four sides surrounding the object.
These are called sizing handles. When you place the mouse pointer directly over a handle, the
pointer changes to a two-headed arrow. Use this mouse pointer to drag the border of the object to
change the size.

I—Sizlng Handles
‘CompanyName )

Since the data field and the field name appear in the report as the same size, you may often need
to select both objects, so you can resize them at the same time. However, if you resize the data
field the field header will also resize, whereas if you resize the field header the data field will not
resize. To select multiple objects, you can use one of two methods:

<> Click the first object to select it. Then, while pressing the SHIFT key or the CTRL key,
click other objects

<> Using the LEFT mouse button, drag a marquee around the objects you want to select.
Make sure the mouse pointer is NOT pointing to an object when you begin to drag.
The marquee you drag selects any object touching the marquee or contained within
the marquee. This process is sometimes referred to as “lassoing” objects

% Exercise 1.3 - Size a Field Using the Resize Handles

1. Select the CompanyName field in the detail section

2. Point to the sizing handle on the right side of the selected object
The mouse pointer changes to a double-headed arrow when you are pointing to the
correct location.

3. Drag to the left to make the data and header fields about 90% of their original size

Notice that Crystal provides a line and shading on the ruler so you can easily see
exactly how wide you are making the objects. Also notice how the field header in the
Page Header section resized itself to match the data field it is associated with. This last
feature reduces time spent matching field headers to data fields in terms of size.
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You can also resize fields to be the same size as another field using the Size command. To do this,
simply multiple select the fields you want to size plus the field that is the size you want to match.
RIGHT click the field that is the size you want, and then choose Size from the Shortcut menu.
Crystal can make all selected fields the same width, height, or overall size as the field on which you
RIGHT clicked.

o,

++ Exercise 1.4 - Resize a Field to Match Another Field

1. Select and resize the field header labeled “City” in the Page Header section. Resize the
field header to be about 1.5” long, which should make it shorter
Notice how the data field “City” doesn't resize to match its associated field header. This
gives us added flexibility in sizing our field headers to be different sizes than their

associated data fields.

2. Multiple select the City data field and its title, then RIGHT click the header field
Be sure you RIGHT click on the header field and not the data field located in the Details
section.

3. Point to Size in the shortcut menu, and then choose Same Width

Crystal makes both the data field and the field header the width of the longer object.

Multiple Selection:
Find in Field Explorer
Format Objects...

Change To Barcode...

Align »
I Size L4 Same Width Rt
X | Cut Same Height
@ | Copy Same Size
=.._J'

Browsing Field Data

If you are not familiar with the data contained in a field, you might not know what size the field
needs to be on the report. Crystal Reports lets you preview the data contained in a field to help
you determine how big a field should be. To view the data in a field, select the field in the Field
Explorer dialog box, and then click the Browse button in the Field Explorer toolbar. If the Field Ex-
plorer dialog box is not open, you can open it by clicking the Field Explorer button on the Toolbar.
You may also right click on a field and select to Browse data.
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s Exercise 1.5 - Browse Field Data

1. Make sure the Field Explorer is still open; if it isn't click the Field Explorer =] button
in the toolbar to open the Field Explorer. Select the Region field in the Data Fields
list

2. Click the Browse Fields £ button

The Browse Field Data dialog box opens.

. ]

- Customers.Region

Type: String
Length: 255

BC

5 £
Co. Cark

DF
D
Isle af Wight
Lara or

'

[ | »

When you are finished viewing the field data, click Close to close the Browse dialog
box.

3. Multiple select the Region field and its field title. Resize them to make both smaller
When you are finished, click away from the objects to deselect them
However, what if you can't see the right edge of the fields to resize them?

4. Select View|Zoom... and select the Fit One Dimension option. Click OK
5. Now, drag the resize handle to resize the Region field so it fits on the page
6. Reset the Zoom dialog box to a Magnification Factor: 100%

f
l NOTE: The Browse dialog box, by default, displays the first 500 unique values in the database.

TIP: You can also open the Browse dialog box by RIGHT clicking the field in the report and choos-

ing Browse Field Data... Be sure you RIGHT click the data field in the Details section, not the field
header object.
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Moving and Aligning Objects

To move a field, you must first select it. Once selected, position the mouse directly over the object
until you see a four-headed arrow. With this arrow, you can move the field by dragging it. To drag

both a data field and its field name at the same time, just multiple select the fields, and then drag
with the four-headed arrow. You can even drag fields from one section of the report to a different
section. You can also move a data field and its field name by simply moving the data field.

The only problem with moving fields like this is they sometimes get out of alignment with their
titles. However, the shortcut menu has an Align command that works similarly to the Size com-
mand you have already used. Just multiple select the fields you want to align, then RIGHT click the
field you want to align to. Choose Align from the shortcut menu and then choose to align on the
left side, the right side, the center, or to the closest grid point.

++ Exercise 1.6 - Move and Align an Object

1. Move the City field header to the left, closer to the CompanyName field
Notice only the title moved. Now it is out of alignment with the field itself.

2. Multiple select the City field and its field header. Then RIGHT click on the field
header

3. Choose Align, then Lefts from the shortcut menu

Crystal aligns the field and its title on the left edge of the title.

Multiple Selection:
Find in Field Explorer
Forrnat Objects...

Change To Barcode...

Align k Tops
Size r Middles [’\}
Dk Cut Bottoms
'__"_‘] Copy Bazeline
Lefts
Centers
Rights
To Grid

TIP: You can also move or size an object with the keyboard. To move an item, select it, and then
= use the arrow keys on the keyboard to move it. If Snap to Grid is turned on, the arrows move
. the item one grid point. If it is turned off, the arrow keys move in very small increments. This is
J referred to as NUDGING an object. To resize using NUDGE, press and hold down the SHIFT key
while pressing an arrow key.
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Using Guides and Guidelines to Move and Align Objects

Although you can simply drag an object to move it, an easier method is to move fields and their
field names using the guidelines. Guidelines are triangular buttons with attached dashed lines that
appear on the ruler bar at the top of the Design window. You can use these guidelines to easily
move and align objects.

Crystal Reports inserts guidelines automatically in these situations:

X Whenever you insert a field in the Details section of a report, the program
automatically creates a guideline at the left edge of the field frame and snaps the field
and field title to it. You can move both the field and the field name, keeping them
aligned, by dragging the guideline marker in the ruler

< If you summarize a field, the program snaps the summary to the same guideline as
the field you summarized to assure proper alignment

<> When you RIGHT click the shaded areas to the left of a section and choose the Arrange
Lines command, the program automatically creates one or more horizontal guidelines
in the section and snaps the fields to them

When you move an object by dragging it with the four-headed arrow, you may move it off the
guideline. If you do this, the object is no longer snapped to the guide and does not move with
the guide. You can re-snap the object, or snap any other object to any guide by moving the left or
right edge of the object so it touches the guide. When an object is snapped to a guideline, small
red marks appear on the edge of the object where it touches the guideline.

Guidline Tell —— ¢
L

Red marks indicate —— _CompanyName

the field is snapped to | T

the guidiine —— CompanyName

You can also work with guidelines manually. Crystal Reports lets you add guidelines and delete
them whenever you need to.

< To add a guideline to the horizontal ruler in any section, click in the ruler where you
want the guideline to appear

< To add a guideline to the vertical ruler, simply click in the ruler where you want the
guideline to appear

<~ To delete a guideline, drag its triangular button (Head) off the ruler
. TIP: You can snap a guideline to a field by moving the guideline to the edge of the field or by
= moving the field’s edge to the guide.

TIP: Guidelines are much easier to work with if you can see the “tails’; that is, the dashed lines

that drop down from the ruler. To turn on the tails, choose File/Options... Click the Show Guide-
lines in Design command, and then click the OK button.
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s Exercise 1.7 - Work with Guidelines

First, turn on the tails for the guidelines. Choose File/Options...

Check on Guidelines in the Design View options of the Layout tab. Also check on the
Grid option and then click OK

Crystal displays the dashed lines extending down from the guideline markers in the
ruler. By making the Grid viewable, it is easier to see field alignment.

Point to the guideline marker for the Region field and drag it to the left. Position it
right after the City field

Since you previously moved the City field by dragging it with the four-headed

arrow, you unsnapped it from its guideline. Using the now unused guideline, move the
guide head to line up the guide tail with the left edge of the City fields

Be sure to look for the red marks to see if the field is snapped to the guideline.

Move the guideline so the Region field and its field name are positioned just to the
right of the City field

Now you need to add another field. Make sure the Field Explorer is still open

Insert the LastYearsSales field to the right of the Region field
Notice the guideline is automatically inserted on the right for numeric fields.

For purposes of this exercise, delete the guideline that was originally used to align the
field by dragging its marker off the ruler

The Last Year’s Sales field is a number. Numbers usually look better if they line up on
the right. Therefore, you need to create a new guideline for this field. Click on the
horizontal ruler at the 7” mark

Crystal creates a new guideline there.

Multiple select the Last Year’s Sales field and its field name, and then drag the objects
so their right edges touch the new guideline

Using the LastYearsSales guide, reposition the fields to the right of the Region fields
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+ Exercise 1.8 - Use the Arrange Lines Command to Align Field Titles Horizontally

1. Click in the Page Header section at the left of the screen with the RIGHT mouse
button
A shortcut menu opens.

2. Choose Arrange Lines
Guidelines appear wherever a field is located in the section and sometimes even where
they don’t appear.

3. Make sure all the field headers are lined up on a single guideline. Move any titles to the

guideline if they are not

4. If you see additional guidelines in the vertical ruler, delete them by dragging them off
the ruler
5. Move the vertical guideline to position the field titles where you want them

WARNING: Be careful when you are moving a guideline. If the mouse pointer is not positioned
in the ruler when you release the mouse button, you will delete the guideline. If this happens,
just create a new guideline by clicking in the ruler where you want it to appeatr or click the Undo
button.

Creating Text Objects

In addition to adding fields to a report, you can also add text objects. A text object is an object in
which you can type any text you wish. It is not related to the underlying database in any way. Typi-
cally, you use text objects as titles or identifiers for summary information. To create a text object,
choose Insert/Text Object from the menus or click the Insert Text Object [£al button on the Toolbar.
The mouse pointer resembles a “crosshairs” from which you can either LEFT click onto the report
to add the default sized text box, or draw a custom sized text box for entering text using the LEFT
mouse button.

When you first insert a text object, it is in Edit mode. You see a flashing insertion bar inside the ob-
ject. You can type text at this point. When you are finished adding text, click away from the object
to finish editing. You cannot end the editing by pressing the ENTER key. This only adds another line
to the text in the object.

TIP: You can tell if you are in Edit mode by looking for the flashing insertion bar. Crystal Reports
also displays a small ruler above the object when you are in Edit mode. If you need to make cor-
rections to an object after you have exited Edit mode, double click the object to return to Edit
mode.
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+ Exercise 1.9 - Insert a Text Object

1. Click the Insert Text Object [2a| button
The mouse pointer displays as a + (crosshairs) symbol until you point into the report.

2. Click in the Report Header section to add the object
The text box appears with a flashing insertion bar.

3. Type Customer Sales

4, Click away from the text object to finish editing

5. Resize the object if necessary to view the entire text on one line
Saving the Report

As with any software, it is a good idea to save your reports frequently in Crystal Reports so you do
not lose work you have done. To save a report, you can choose File/Save from the menu or click the
Save [ button on the Toolbar.

The first time you save a report, Crystal Reports opens the Save As dialog box. In this box, you can
specify a folder location for the report and give the report a filename. The six icons on the left give
you one click access to common locations.

Savein: ||, CR2008 - E‘ [,: E ' = =
Name Date modif... Type Size Tags
This folder is empty.

File name: Basic2008] Save

Save as type: [Crystdﬂ&ports v] [ Cancel ]
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The Desktop icon lets you save this report your Windows Desktop

My Documents opens the Windows My Documents folder on Windows 2000/XP
systems or the user Documents directory on Windows Vista

The Favorites folder opens the list of favorite folders you have specified in Internet
Explorer. If you have a folder where you want to keep all of your reports, add it to the
Favorites folder, then it is easily accessible from here

The CR.COM option provides the ability to publish the report to a specific CR.COM
(crystalreports.com) account. The crystalreports.com connectivity module must be
installed to use this feature

Enterprise lets you save your report to an Enterprise folder

My Connections offers a list of saved connections to either crystalreports.com or
Enterprise. This makes it easier to publish to multiple locations without having to con
figure connection settings each time

Once you have saved and named a file, the Save command automatically overwrites the previous
version of the file with the revised version. Crystal Reports does not prompt you to overwrite. If
you want to preserve the previous version of the report, you must use the Save As command on
the File menu to give the revised report a new name.

Autosaving the Report

Crystal Reports has an Autosave feature that automatically saves the report for you in a time frame
you specify. To turn on the Autosave feature, choose File/Options from the menu and then select
the Reporting tab.

You can check mark the Autosave Reports After command, then enter the number of minutes
between saves.
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Options
Fonts | Smart Tag & HTML Preview I Dependency Checker
Layout I Database I Formula Editor | Reporting | Fields
Enterprise Settings

Update Enterprize Report Properties on Save
[] Update Connected Repository Ohjects on Open

Reading Data

[] Convert Database MULL Values to Defautt
[7] Convert Cther NULL Values to Default

[] Always Sort Localy

[¥] 5ave Data With Report

[7] Discard Saved Data on Open

[7] Re<import Subreport on Open

[7] Suppress Prirting if Mo Records Selected

[7] Show Al Headers on Drill Down

[7] Autosave Reports After 5 Minutes
Display Alerts on Refresh

[¥] Save Preview Picture

[] Retain Criginal Image Color Depth

[ ok || Cancel || Hep
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+» Exercise 1.10 - Save the Report

1. Click the Save L= button on the Toolbar
Crystal Reports opens the Save As dialog box.

2. Select the My Documents button

3. Create a new directory and name it CR2008
4, Name the report Basic2008

5. When finished, click the Save button
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Previewing the Report

When you have saved the report, you can see how it looks with collected data by using the Pre-
view command.

To preview the report for the first time, choose File/Print or click the Print Preview button [d on the
toolbar. Crystal Reports creates a Preview tab and displays the report similar to how it will look
when printed. Once you have created the Preview tab, you can switch between Design and Pre-
view views by clicking the appropriate tab.

Start Page Basic2008.rpt X

Design | Preview X|

CustomerlD CompanyMame City Region LastY earsSales
1,066.00 Reggiani Caseifici Reggio Emilia $3,203.60 |
1,067.00 Ricardo Adocicados Rio de Janeiro RJ $4.338.90 |
1,068.00 Richter Supermarkt Genéve 512,044.80
1,070.00 Santé Gourmet Stavern $700.00
1,071.00 Save-a-lot Markets Boize 1D §60,672.64
1,072.00 Seven Seas|Impors London $9,597.65
1,073.00 Simons bistro Kobenhavn §17,482.15
1,074.00 Spécialités du monde Faris $52.35
1,075.00 Split Rail Beer & Ale Lander WY $2,972.50
1,076.00 Suprémes délices Charleroi $6,403.10
1,077.00 The Big Cheese Portland OR $2,955.40
1,078.00 The Cracker Box Butte MT $1,621.24
1,079.00 Toms Spezialitaten Minster $2,180.20
1,080.00 Tortuga Restaurante México D.F. $5.523.35
1,081.00 Tradigdo Hipermercadc Sao Paulo 5P $1,613.00
1,082.00 Trail's Head Gourmet F Kirkland WA $1.333.30
1,083.00 Vaffeljernet Arhus $9,710.50
1,084.00 Victuailles en stock Lyon $6,099.50
1,085.00 Vins et alcools Chevalit Reims $379.80
1,086.00 Die Wandernde Kuh Stuttgart $5,217.65
1,087.00 Warian Herkku Culu $13,106.30
1,088.00 Wellington Importadore Resende 5P $4,717.90

For Help, press FL 4/27/2008 10:50AM Records: 86 | El=

In the toolbars area you should see the Navigation toolbar. Usually it will be located in the bottom
row to the very right.

= W4 1ofl+ b M
< Use the == button to refresh the data
X Use the 4and ¥ buttons to move through the report one page at a time.
X Use the M or M to display the first or last page of the report
< The “¥ button stops the processing of the report and displays the report with

whatever data it has gathered up to the point you stopped the processing
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The page indicator in the middle of the arrow buttons indicates the page you are
viewing and the total number of pages in the report. Crystal formats the report only
to display requested pages to save time when previewing the report. If you see a +
sign after the total page count, that means that Crystal has not formatted all the pages
of the report, so the total count is not known. To get the actual total page count, go to
the last page of the report

Refreshing the Data

When you preview a report, Crystal Reports queries the underlying database, pulls the records
you requested, then saves the retrieved records in a combination of active memory and disk files.
Thereafter, Crystal Reports works with the same dataset on the local machine rather than re-
guerying the database. Once you have pulled the initial set of records, Crystal Reports can work
very quickly because it does not have to re-query the database each time you want to preview
the results of your work. If you want Crystal Reports to re-query the database, you can choose to
refresh the data.

Crystal Reports automatically refreshes the data in certain circumstances:

When you add additional fields to the report

When you add criteria that causes Crystal Reports to select additional records from the
database

When you add a formula that uses a field not currently being used in the report

If you want Crystal Reports to automatically discard the saved data and pull new

data from the database whenever you open the report, you can specify for Crystal to
do this. Choose File/Options, select the Reporting tab, and then check the Discard
Saved Data on Open command. You can refresh the data manually whenever you want
by choosing Report/Refresh Report Data, or by clicking the Refresh == button on the
Toolbar
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+» Exercise 1.11 - Preview the Report

1. Click the Print Preview [d button

2. Click the page navigation buttons to view different pages of the report

3. Click the navigation buttons to view the first and last pages of the report
Notice the change in the total page count after you have navigated to the last page of
the report.

4, Click the Close button on the Preview tab to close it

5. Click the Print Preview button to restore the tab

6. Click the Design tab to return to Design view. Click the Save button again to save the
report

Using the Status Bar

The Status bar offers additional value beyond providing descriptions of selected objects. When in
Preview mode, the Status bar shows:

X Data and time of last database refresh
X Number of records retrieved and saved
X Zoom controls - The Zoom control can be used in both Design and Preview mode.

Features include the ability to quickly view the whole page, width only or to set the
percentage dimension

P NOTE: When you preview the report, you may see a blank white area on the left of the screen
f - along with Groups, Parameters and Find options. This is the Preview Panel area. You will learn
l J more about using this later. For now, you can turn this off by clicking the Toggle Preview Panel
[T button on the Standard toolbar.
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Getting Help

You can obtain help on Crystal Reports by choosing Help, Crystal Reports Help or by pressing the

F1 key.

EQ Crystal Reports Online Help [ [ ]
ol B

Hide: Back Fonward Prnt  Options

»

Q::nterrtsl Index I §earch| Fa\rori_tes| Crystal Reports Online Help

C Y Introduction to Crystal Report§i® Introduction to Crystal Reports 2008

@ Additional Help
@ Introduction to Reporting

@ BusinessObjects Enterprise |

@ Record Selection = C RYSTA L
@ Sorting, Grouping, and Totalir

@ Running Totals RE PORTS
@ Multiple Section Reports -
@ Formatting

@ Charting

@ Mapping
& OLE Access our product documentation online

. at:
% ers.s_Tab UD.JEHS hitp:ifsupport. businessobjects. comidocumer
@ Building Queries

m

Help | Aide | Hilfe | Guida in linea | Ayuda

@ Creating and Updating OLAP » About Crystal Reports
@ Using the OLAP Worksheet » Aboutthe Crystal Reports
mlﬁ Printina. Exnortinu.land Viewil ™ documentation -
4 I I N
4| i §

The left side of the screen provides help in locating the information you want.

R/
0'0
0

0'0

R/
0'0

R/
°

Contents shows a table of expandable subjects through which you can look for
information. Think of this as a table of contents

Index provides a search method that looks through screen titles. Just type the keyword
you want. Crystal Help interactively displays topics with the keyword in the title

Search is a word search option that searches help screen text. Again, type the keyword
or words you want, and then click the List Topics button to see a listing of screens that
contain your keyword

Favorites display a list of topics you have added as favorites

TIP: If you need help on functions in the Formula Editor, look them up by the function name or
by the general category to which they belong. For example, search for the function name Repli-
cateString. If you cannot find the function by searching for the name, then look up the general
category to which it belongs. You cannot locate For Loop by searching for the name, but you can
find it by searching for its category, Control Structures.
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Challenge Exercise - Creating a Basic Report

Create a report that lists orders with important date and payment information.

1.

10.

11.

Select File Menu|New|Blank Report from the Menu bar
Note if you click on the New Report button by default you will be taken into the
Standard Report expert.

File | View Help

Mew k| [ | Standard Report... Ctrl+HM
| Open... Ctrl+0 Blank Report...
Close Cross-Tab Report... %

Mailing Label Report...
OLAP Cube Report...

Options...

Create this report as a Blank Report

In the Database Expert window, open the My Connections folder, the Northwind
2008 database connection, Tables and then add the Orders table. Click OK

Add the following fields to the Details section: OrderID, OrderDate, RequiredDate,
ShippedDate and OrderAmount

The OrderID and OrderAmount fields are number fields. Notice how Crystal Reports
provides guidelines on the right edges of these fields. This is because number fields are
right-aligned by default.

Browse the OrderDate field to see what the date looks like. When you are finished,
close the Browse box

Notice the field shows both the date and the time. It needs to be about 1.5” long to display
all the data.

Resize the OrderDate field to be 1.5"long

Using the Size command on the shortcut menu, resize the RequiredDate and the
ShippedDate fields to be the same width as OrderDate
Notice how the field headers automatically resize the same as the data fields.

Use guidelines to position the fields so they look good to you
Add a text box to the Report Header section. Type Unpaid Orders

Save the report. Name it Unpaid Orders. Preview the report then re-save it after you
have previewed

When finished, close the report
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The Preview view of the report should look similar to the following illustration:

Design |PIE’;EE(|

Unpaid Orders

OrderdD OrderDate RequiredDate ShippedDate OrderAmount
10,248.00 7/4/2006 12:00:00AM /112006 12:00:00AM THMB/2006 12:00:00AM $440.00
10,249.00  7/5/2006 12:00:00AM 8/16/2006 12:00:00AM TM0/2006 12:00:00AM $1,863.40
10,250.00 7/8/2006 12:00:00AM 8/5/2006 12:00:00AM TM2/2006 12:00:00AM $1,813.00
10,251.00  7/8/2006 12:00:00AM 8/5/2006 12:00:00AM TM5/2006 12:00:00AM $670.80
10,252.00 792006 12:00:00AM 8/6/2006 12:00:00AM TM12006 12:00:00AM $3,730.00
10,253.00 7M0/2006 12:00:00AM 71242006 12:00:00AM TMB/2006 12:00:00AM $1,444 80
1025400 7M1/2006 12:00:00AM 8/8/2006 12:00:00AM TI23/2006 12:00:00AM $625.20
1025500  TM2/2006 12:00:00AM 8/9/2006 12:00:00AM TM5/2006 12:00:00AM §2,490.50
10,256.00  7/15/2006 12:00:00AM 8/M2/2006 12:00:00AM TH7I2006 12:00:00AM §517.80
10,257.00  7/M6/2006 12:00:00AM 8/13/2006 12:00:00AM TI22/2006 12:00:00AM $1,119.90
10,258.00 772006 12:00:00AM 28/14/2006 12:00:00AM TI23/2006 12:00:00AM §2 018.60
1025900 7/M8/2006 12:00:00AM 8/15/2006 12:00:00AM TI25/2006 12:00:00AM §100.80
10,260,000  7/19/2006 12:00:00AM 8/M1M6/2006 12:00:00AM TI29/2006 12:00:00AM $1,746.20
10,261.00  7/M9/2006 12:00:00AM a8/16/2006 12:00:00AM Tr30/2006 12:00:00AM §448.00
1026200 7/22/2006 12:00:00AM 8/19/2006 12:00:00AM TI25/2006 12:00:00AM 5624 80
10,263.00  7/23/2006 12:00:00AM 8/20/2006 12:00:00AM TI31/2006 12:00:00AM 52 46480
10,264.00 7/24/2006 12:00:00AM 8/21/2006 12:00:00AM 8/23/2006 12:00:00AM $724.50
10, 265.00 7/25/2006 12:00:00AM 8/22/2006 12:00:00AM 8M2/2006 12:00:00AM $1176.00
A0 2RA 00 FIPRZO0A 17200 004 M QR2006 12-00 004 M TAAZ006 1200 004 M R3R4 A0 A

i
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